
NORTH LOUISIANA

C O N N E C T I N G  A D V E R T I S E R S  T O 

L O U I S I A N A  A N D  B E Y O N D

Effective May 1, 2021

NORTH LOUISIANA



NORTH LOUISIANA

local news.
local expertise.
local ownership.
local matters.

When you advertise with us, you’re not just 
running a traditional ad campaign. You’re 
leveraging the power of a locally owned 
company that listens to and understands the 
communities it serves. 

Trust matters. Relationships matter. 
And ultimately, results matter. That’s what we 
bring to the table. Have a seat. Let’s get started.



NORTH LOUISIANA

Unmatched reach to a premium 
audience of newspaper and 
newspaper website readers

New Orleans metro area

Baton Rouge metro area

Acadiana (including Lafayette and Alexandria)

statewide digital reach

print and digital reach

print and digital reach

print and digital reach

+



NORTH LOUISIANA

Total digital reach

10 MILLION
TOTAL UNIQUE VISITORS PER MONTH

2.1 MILLION
UNIQUE MONTHLY VISITORS

NEW ORLEANS DMA

952,800
UNIQUE MONTHLY VISITORS

BATON ROUGE DMA

3.5 MILLION STATEWIDE UNIQUE MONTHLY VISITORS

269,000
UNIQUE MONTHLY VISITORS

LAFAYETTE DMA

*July – October  2019 – Google Analytics



NORTH LOUISIANA

Total print reach - New Orleans

593,000*

PRINT READERS

*Scarborough Research R1, New Orleans DMA–February 2019 - March 2020

CANTON, Ohio — After this
year’s Pro Football Hall of
Fame Class was announced
in February, one of the first
things Ed Reed did was walk
over and thank Johnny
Robinson.
The reason was twofold.
“For one, I couldn’t believe

they didn’t let
him in sooner,”
Reed said on
Friday. “Check
Johnny’s stats.
He’s one of the
best to ever
do it. I always
like to thank
the pavers that
came before
me.”
And reason
No. 2?
“It’s just out of

respect,” Reed
said. “And he’s
a Louisiana guy,
and that made it
even more spe-
cial for me.”

Louisiana’s special night
continued Saturday as the
state stuck a giant feather in
its cap on football’s most ex-
clusive stage.
Reed, a St. Rose native,

along with former LSU stand-
outs Kevin Mawae of Lees-
ville and Robinson of Baton
Rouge, were inducted into the
Pro Football Hall of Fame,
giving Canton a giant pot of
Louisiana gumbo-like flavor.
Louisiana, as you know, of-

ten ranks somewhere toward
the bottom in those quality-of-
life rankings you often see.

Johnson,Van Pran
may beWarren
Easton’s best
weapon for title.
Page 3C

Murray, Williams return to work after missing four days of Saints training camp

ä Pro
Football
Hall of Fame
ceremony
coverage.
Page 6-7C

In this HOF
class,

Louisiana
stands tall
and proud

TIME
OUT
ROD
WALKER

EGENDARY

ä See WALKER, page 6C

BY HERBIE TEOPE
Staff writer

The Saints on Saturday had a
welcome sight on the practice
field.
After missing four straight

team practices, running back
Latavius Murray and safety
Marcus Williams were back to
work in full pads and appeared
to practice without limitations.
“Obviously, it is good to have

guys like that get back out after
the rehab,” coach Sean Payton
said. “Both of them should be
pretty healthy. I amsure there’s
a lot of soreness right now with
a number of players.”
While it remains unclear as

to the extent of their injuries or
the cause,Murray andWilliams
provided a hint in recent days
that they were close to return-
ing to action.
After being absent Monday

and Tuesday, the two players
participated Thursday and Fri-
day in the stretching and con-
ditioning portion of practice,
which has been conducted in-
sideover thepast threedaysbe-
fore the teammoves outdoors.
Murray and Williams went
outside Friday in pads and
worked off to the side with
trainers before going back in-
side while the rest of the team
practiced.

On Saturday, it didn’t take
long to see Murray and Wil-
liams in full actionduringoneof
the team’s early 11-on-11 drills
featuring the starting offense
against the starting defense.
Murray took a handoff from
quarterback Drew Brees and
ran inside before cutting out-
side at full speed. Williams was
initially caught up inside, but

BACK INACTION

ä See SAINTS, page 4C

STAFF PHOTO BY DAVID GRUNFELD
Saints running back Latavius Murray, left, gets by free safety
Marcus Williams during training camp in Metairie on Saturday.

ASSOCIATED PRESS PHOTO BY SCOTT HECKEL
Ed Reed, a member of the Pro Football Hall of Fame Class of 2019, receives his gold jacket from his father,
Edward Reed Sr., during the Gold Jacket Dinner in Canton, Ohio, on Friday.

BY BROOKS KUBENA
Staff writer

LSU junior center LloydCushenber-
ry sat silently as Ed Orgeron stepped
forwardwith two jerseys in his hands.
Two players would be wearing the

team’shonoraryNo. 18 in the2019 sea-
son, the Tigers head coach explained
in a team meeting Thursday night.
One was outside linebacker K’Lavon
Chaisson. The other, Orgeron hinted,
would be the first LSU offensive line-
man to ever receive the number.
Cushenberry was in shock when he

heard his name.
“It took me a while to stand up,” he
recalled Saturday. “It tookme awhile
to stand up. I didn’t
knowwhat to say.”
Those who know

Cushenberry best
would not be surprised
by his speechless re-
sponse.
LSU’s returning start-
ing center has always
been known as a quiet
man, an introverted
playerwho speaks onlywhenheneeds
to.
Little league football coaches re-

membered how they’d coached Cush-
enberry for two years and had only
heard his voice once.
His coaches at DutchtownHigh had
to pull words out of their young line-
man on a recruiting road trip.
Even at LSU, players aren’t used
to hearing their center’s voice boom
inside the expansive rooms inside the
program’s new football operations
building.
But when Cushenberry speaks?
Heads turn.
“I think that’s the best kind of lead-

ership,” LSU quarterback Joe Bur-
row said. “You have some leaders that

THE
QUIET
MAN

1C
SUNDAY

AUGUST 4, 2019sportssportssports
NOLA.COM

BY NATHAN BROWN
Staff writer

With all the hype surrounding
teams in LosAngeles andNewYork,
combined with the success of some
of the league’s premier franchises,
the Pelicans have been an after-
thought when the NBA considers
which teams to roll out for its open-
ing night.
Not anymore.
According to a report from The

Athletic, the Pelicans will face the

reigning champion Toronto Raptors
on Oct. 22, the NBA’s first night of
regular-season action. The Lakers
and Clippers also face off the same
evening, kicking off an anticipated
season after a summer full of All-
Star-caliber free-agent turnover and
an exciting top-level draft class.
It appears very likely that game

will be inNewOrleans and fans’ first
chance to see rookie sensation Zion
Williamson in the Smoothie King
Center for a regular-season game.
That WILL be the home-opener at

the Smoothie King Center, because
Elton John’s ‘Farewell Yellow Brick
Road’ tour is hitting Scotiabank on
that same night.
It is common for reigning champi-

ons to play the next season’s debut
at home, but Elton John is scheduled
to play concerts as part of his ‘Fare-
well YellowBrick Road’ tour on Oct.
22-23 in Toronto at the Raptors’ Sco-
tiabank Arena. The tour has stops in
Milwaukee on Oct. 19 and in India-
napolis onOct. 25,meaning resched-
uling the concert date would likely

be very difficult.
Should the teams play in New Or-
leans, the Raptors would be the first
reigningNBAchampions to open the
season on the road since the 2000-01
Lakers played their season debut
at Portland on Halloween to defend
their first of three consecutive titles.
Google’s unofficial event listings

for the Smoothie King Center also
have Oct. 22 as the team’s home
opener.

Pels to open season against Raptors, likely in N.O.

ä See PELICANS, page 2C

From last-day signee to
No. 18, Cushenberry

becomes voice of Tigers

STAFF FILE PHOTO
LSU offensive linemen Lloyd
Cushenberry waits for the start of a
drill during practice on Aug. 21, 2017.

ä Tulane
junior

Kuerschen
pumped to
start at free

safety.
Page 9C

ä See LSU, page 8C
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BY SUZANNE PFEFFERLE TAFUR
Contributing writer

One of Touro Infirmary’s newest
employees is a bit of a celebrity.
When he moseys

through the health
care center’s Prytania
Street campus, people
rush toward him, hop-
ing for a quick cuddle.
But his uniform clear-
ly states, “Please don’t
pet me, I’m working”
— so they smile and
coo instead.
That’s because this

recent hire is a frisky,
4-month-old yellow Labrador re-
triever, training to become a ther-
apy dog.His name, stamped on his

plastic work badge, is Touro.
“Patients and staff are over-
whelmingly happy to see him,”
said Maggie Homer, a speech
therapist at Touro Infirmarywho’s
in charge of raising the pup.
“It can take us 15minutes to get
inside the hospital,” she said. “Ev-
erybody is calling him, and he’s
looking everywhere.”
Then, she said, Touro gets tired

and “splats” on his belly.

Veterans and dogs
The canine eventually makes

his way into the Touro Rehabili-
tation Center, where he works
alongside fellow Lab Indie, 3
months old.
Both puppies arrived at Touro

through a partnership with Unit-

ed States Veterans Service Dogs,
aMarrero-based organization that
pairs veterans with physical and
mental disabilities with a service
dog.
“The USVSD breeds dogs to be-

come service dogs, and then they
find volunteers to be puppy rais-
ers,” said Maggie Watson, Indie’s
puppy raiser and a physical thera-
pist at Touro.
Cody Bellanger, the CEO and

director of training and client
services for the veterans organi-
zation, was familiar with Touro’s
Rehabilitation Center and thought
the facility would be an ideal set-
ting for a program that pairs Tou-
ro’s staff with puppies.

LABS LEARN HOW TO ASSIST DISABLED
VETERANS AT NEW ORLEANS REHAB CENTER

Labrador puppies Indie
and Touro are training at
Touro Infirmary to become
service dogs for veterans.

STAFF PHOTOS
BY SOPHIA GERMER

ABOVE: Maggie
Watson, left, with
Indie, and Maggie
Homer, with Touro,
use positive, rewards-
based training to
teach the puppies
basic commands.
LEFT: Touro wears a
vest and official name
tag, alerting humans
to his status as a
service dog in training.

BY MARI A. SCHAEFER
The Philadelphia Inquirer (TNS)

There seems to be very little
that Republicans and Demo-
crats agree upon in these times
of harsh political discourse, but
aDrexelUniversity researcher
may have found one: the role of
scientific evidence in develop-
ing and shaping health care.
In a 2018 survey, 532 Ameri-

cans were asked to identify
with a political party and then
rate the extent to which six
factors such as industry influ-
ences, evidence and budget
“should have” and “currently
have” on the decisions made
by representatives in the U.S.
Congress.
The survey also looked at the

influencedoctor groups and cit-
izens had on health policy. The

study was published last week
in the journal Translational Be-
havioral Medicine.
“Policymaking is political at

the end of the day,” said Jona-
than Purtle, study author and
assistant professor of health
management and policy in
Drexel’s Dornsife School of
Public Health.

What Republicans and Democrats
agree upon may surprise you

ä See AGREE, page 2D

Previous studies
have found that

groups that
represent doctors,
like the American

Medical Association,
are extremely

powerful in shaping
healthy policy, but
a new study found
that doctors were

not thought to have
much influence.

PROVIDED PHOTO BY
METRO SOURCE

PUPPY’SpurposeA

ä To see
a video of
the pups,
go to nola.

com.

ä See PUPPY, page 2D
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CANTON, Ohio — After this
year’s Pro Football Hall of
Fame Class was announced
in February, one of the first
things Ed Reed did was walk
over and thank Johnny
Robinson.
The reason was twofold.
“For one, I couldn’t believe

they didn’t let
him in sooner,”
Reed said on
Friday. “Check
Johnny’s stats.
He’s one of the
best to ever
do it. I always
like to thank
the pavers that
came before
me.”
And reason
No. 2?
“It’s just out of

respect,” Reed
said. “And he’s
a Louisiana guy,
and that made it
even more spe-
cial for me.”

Louisiana’s special night
continued Saturday as the
state stuck a giant feather in
its cap on football’s most ex-
clusive stage.
Reed, a St. Rose native,

along with former LSU stand-
outs Kevin Mawae of Lees-
ville and Robinson of Baton
Rouge, were inducted into the
Pro Football Hall of Fame,
giving Canton a giant pot of
Louisiana gumbo-like flavor.
Louisiana, as you know, of-

ten ranks somewhere toward
the bottom in those quality-of-
life rankings you often see.

Johnson,Van Pran
may beWarren
Easton’s best
weapon for title.
Page 3C

Murray, Williams return to work after missing four days of Saints training camp
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coverage.
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ä See WALKER, page 6C

BY HERBIE TEOPE
Staff writer

The Saints on Saturday had a
welcome sight on the practice
field.
After missing four straight

team practices, running back
Latavius Murray and safety
Marcus Williams were back to
work in full pads and appeared
to practice without limitations.
“Obviously, it is good to have

guys like that get back out after
the rehab,” coach Sean Payton
said. “Both of them should be
pretty healthy. I amsure there’s
a lot of soreness right now with
a number of players.”
While it remains unclear as

to the extent of their injuries or
the cause,Murray andWilliams
provided a hint in recent days
that they were close to return-
ing to action.
After being absent Monday

and Tuesday, the two players
participated Thursday and Fri-
day in the stretching and con-
ditioning portion of practice,
which has been conducted in-
sideover thepast threedaysbe-
fore the teammoves outdoors.
Murray and Williams went
outside Friday in pads and
worked off to the side with
trainers before going back in-
side while the rest of the team
practiced.

On Saturday, it didn’t take
long to see Murray and Wil-
liams in full actionduringoneof
the team’s early 11-on-11 drills
featuring the starting offense
against the starting defense.
Murray took a handoff from
quarterback Drew Brees and
ran inside before cutting out-
side at full speed. Williams was
initially caught up inside, but

BACK INACTION

ä See SAINTS, page 4C

STAFF PHOTO BY DAVID GRUNFELD
Saints running back Latavius Murray, left, gets by free safety
Marcus Williams during training camp in Metairie on Saturday.

ASSOCIATED PRESS PHOTO BY SCOTT HECKEL
Ed Reed, a member of the Pro Football Hall of Fame Class of 2019, receives his gold jacket from his father,
Edward Reed Sr., during the Gold Jacket Dinner in Canton, Ohio, on Friday.

BY BROOKS KUBENA
Staff writer

LSU junior center LloydCushenber-
ry sat silently as Ed Orgeron stepped
forwardwith two jerseys in his hands.
Two players would be wearing the

team’shonoraryNo. 18 in the2019 sea-
son, the Tigers head coach explained
in a team meeting Thursday night.
One was outside linebacker K’Lavon
Chaisson. The other, Orgeron hinted,
would be the first LSU offensive line-
man to ever receive the number.
Cushenberry was in shock when he

heard his name.
“It took me a while to stand up,” he
recalled Saturday. “It tookme awhile
to stand up. I didn’t
knowwhat to say.”
Those who know

Cushenberry best
would not be surprised
by his speechless re-
sponse.
LSU’s returning start-
ing center has always
been known as a quiet
man, an introverted
playerwho speaks onlywhenheneeds
to.
Little league football coaches re-

membered how they’d coached Cush-
enberry for two years and had only
heard his voice once.
His coaches at DutchtownHigh had

to pull words out of their young line-
man on a recruiting road trip.
Even at LSU, players aren’t used
to hearing their center’s voice boom
inside the expansive rooms inside the
program’s new football operations
building.
But when Cushenberry speaks?
Heads turn.
“I think that’s the best kind of lead-

ership,” LSU quarterback Joe Bur-
row said. “You have some leaders that

THE
QUIET
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AUGUST 4, 2019sportssportssports
NOLA.COM

BY NATHAN BROWN
Staff writer

With all the hype surrounding
teams in LosAngeles andNewYork,
combined with the success of some
of the league’s premier franchises,
the Pelicans have been an after-
thought when the NBA considers
which teams to roll out for its open-
ing night.
Not anymore.
According to a report from The

Athletic, the Pelicans will face the

reigning champion Toronto Raptors
on Oct. 22, the NBA’s first night of
regular-season action. The Lakers
and Clippers also face off the same
evening, kicking off an anticipated
season after a summer full of All-
Star-caliber free-agent turnover and
an exciting top-level draft class.
It appears very likely that game

will be inNewOrleans and fans’ first
chance to see rookie sensation Zion
Williamson in the Smoothie King
Center for a regular-season game.
That WILL be the home-opener at

the Smoothie King Center, because
Elton John’s ‘Farewell Yellow Brick
Road’ tour is hitting Scotiabank on
that same night.
It is common for reigning champi-

ons to play the next season’s debut
at home, but Elton John is scheduled
to play concerts as part of his ‘Fare-
well YellowBrick Road’ tour on Oct.
22-23 in Toronto at the Raptors’ Sco-
tiabank Arena. The tour has stops in
Milwaukee on Oct. 19 and in India-
napolis onOct. 25,meaning resched-
uling the concert date would likely

be very difficult.
Should the teams play in New Or-
leans, the Raptors would be the first
reigningNBAchampions to open the
season on the road since the 2000-01
Lakers played their season debut
at Portland on Halloween to defend
their first of three consecutive titles.
Google’s unofficial event listings

for the Smoothie King Center also
have Oct. 22 as the team’s home
opener.

Pels to open season against Raptors, likely in N.O.

ä See PELICANS, page 2C

From last-day signee to
No. 18, Cushenberry

becomes voice of Tigers

STAFF FILE PHOTO
LSU offensive linemen Lloyd
Cushenberry waits for the start of a
drill during practice on Aug. 21, 2017.

ä Tulane
junior

Kuerschen
pumped to
start at free

safety.
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BY SUZANNE PFEFFERLE TAFUR
Contributing writer

One of Touro Infirmary’s newest
employees is a bit of a celebrity.
When he moseys

through the health
care center’s Prytania
Street campus, people
rush toward him, hop-
ing for a quick cuddle.
But his uniform clear-
ly states, “Please don’t
pet me, I’m working”
— so they smile and
coo instead.
That’s because this

recent hire is a frisky,
4-month-old yellow Labrador re-
triever, training to become a ther-
apy dog.His name, stamped on his

plastic work badge, is Touro.
“Patients and staff are over-
whelmingly happy to see him,”
said Maggie Homer, a speech
therapist at Touro Infirmarywho’s
in charge of raising the pup.
“It can take us 15minutes to get
inside the hospital,” she said. “Ev-
erybody is calling him, and he’s
looking everywhere.”
Then, she said, Touro gets tired

and “splats” on his belly.

Veterans and dogs
The canine eventually makes

his way into the Touro Rehabili-
tation Center, where he works
alongside fellow Lab Indie, 3
months old.
Both puppies arrived at Touro

through a partnership with Unit-

ed States Veterans Service Dogs,
aMarrero-based organization that
pairs veterans with physical and
mental disabilities with a service
dog.
“The USVSD breeds dogs to be-
come service dogs, and then they
find volunteers to be puppy rais-
ers,” said Maggie Watson, Indie’s
puppy raiser and a physical thera-
pist at Touro.
Cody Bellanger, the CEO and

director of training and client
services for the veterans organi-
zation, was familiar with Touro’s
Rehabilitation Center and thought
the facility would be an ideal set-
ting for a program that pairs Tou-
ro’s staff with puppies.

LABS LEARN HOW TO ASSIST DISABLED
VETERANS AT NEW ORLEANS REHAB CENTER

Labrador puppies Indie
and Touro are training at
Touro Infirmary to become
service dogs for veterans.

STAFF PHOTOS
BY SOPHIA GERMER

ABOVE: Maggie
Watson, left, with
Indie, and Maggie
Homer, with Touro,
use positive, rewards-
based training to
teach the puppies
basic commands.
LEFT: Touro wears a
vest and official name
tag, alerting humans
to his status as a
service dog in training.

BY MARI A. SCHAEFER
The Philadelphia Inquirer (TNS)

There seems to be very little
that Republicans and Demo-
crats agree upon in these times
of harsh political discourse, but
aDrexelUniversity researcher
may have found one: the role of
scientific evidence in develop-
ing and shaping health care.
In a 2018 survey, 532 Ameri-

cans were asked to identify
with a political party and then
rate the extent to which six
factors such as industry influ-
ences, evidence and budget
“should have” and “currently
have” on the decisions made
by representatives in the U.S.
Congress.
The survey also looked at the

influencedoctor groups and cit-
izens had on health policy. The

study was published last week
in the journal Translational Be-
havioral Medicine.
“Policymaking is political at

the end of the day,” said Jona-
than Purtle, study author and
assistant professor of health
management and policy in
Drexel’s Dornsife School of
Public Health.

What Republicans and Democrats
agree upon may surprise you

ä See AGREE, page 2D

Previous studies
have found that

groups that
represent doctors,
like the American

Medical Association,
are extremely

powerful in shaping
healthy policy, but
a new study found
that doctors were

not thought to have
much influence.

PROVIDED PHOTO BY
METRO SOURCE
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ä To see
a video of
the pups,
go to nola.

com.

ä See PUPPY, page 2D
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CANTON, Ohio — After this
year’s Pro Football Hall of
Fame Class was announced
in February, one of the first
things Ed Reed did was walk
over and thank Johnny
Robinson.
The reason was twofold.
“For one, I couldn’t believe

they didn’t let
him in sooner,”
Reed said on
Friday. “Check
Johnny’s stats.
He’s one of the
best to ever
do it. I always
like to thank
the pavers that
came before
me.”
And reason
No. 2?
“It’s just out of

respect,” Reed
said. “And he’s
a Louisiana guy,
and that made it
even more spe-
cial for me.”

Louisiana’s special night
continued Saturday as the
state stuck a giant feather in
its cap on football’s most ex-
clusive stage.
Reed, a St. Rose native,

along with former LSU stand-
outs Kevin Mawae of Lees-
ville and Robinson of Baton
Rouge, were inducted into the
Pro Football Hall of Fame,
giving Canton a giant pot of
Louisiana gumbo-like flavor.
Louisiana, as you know, of-

ten ranks somewhere toward
the bottom in those quality-of-
life rankings you often see.

Johnson,Van Pran
may beWarren
Easton’s best
weapon for title.
Page 3C

Murray, Williams return to work after missing four days of Saints training camp
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BY HERBIE TEOPE
Staff writer

The Saints on Saturday had a
welcome sight on the practice
field.
After missing four straight

team practices, running back
Latavius Murray and safety
Marcus Williams were back to
work in full pads and appeared
to practice without limitations.
“Obviously, it is good to have

guys like that get back out after
the rehab,” coach Sean Payton
said. “Both of them should be
pretty healthy. I amsure there’s
a lot of soreness right now with
a number of players.”
While it remains unclear as

to the extent of their injuries or
the cause,Murray andWilliams
provided a hint in recent days
that they were close to return-
ing to action.
After being absent Monday

and Tuesday, the two players
participated Thursday and Fri-
day in the stretching and con-
ditioning portion of practice,
which has been conducted in-
sideover thepast threedaysbe-
fore the teammoves outdoors.
Murray and Williams went
outside Friday in pads and
worked off to the side with
trainers before going back in-
side while the rest of the team
practiced.

On Saturday, it didn’t take
long to see Murray and Wil-
liams in full actionduringoneof
the team’s early 11-on-11 drills
featuring the starting offense
against the starting defense.
Murray took a handoff from
quarterback Drew Brees and
ran inside before cutting out-
side at full speed. Williams was
initially caught up inside, but

BACK INACTION

ä See SAINTS, page 4C

STAFF PHOTO BY DAVID GRUNFELD
Saints running back Latavius Murray, left, gets by free safety
Marcus Williams during training camp in Metairie on Saturday.

ASSOCIATED PRESS PHOTO BY SCOTT HECKEL
Ed Reed, a member of the Pro Football Hall of Fame Class of 2019, receives his gold jacket from his father,
Edward Reed Sr., during the Gold Jacket Dinner in Canton, Ohio, on Friday.

BY BROOKS KUBENA
Staff writer

LSU junior center LloydCushenber-
ry sat silently as Ed Orgeron stepped
forwardwith two jerseys in his hands.
Two players would be wearing the
team’shonoraryNo. 18 in the2019 sea-
son, the Tigers head coach explained
in a team meeting Thursday night.
One was outside linebacker K’Lavon
Chaisson. The other, Orgeron hinted,
would be the first LSU offensive line-
man to ever receive the number.
Cushenberry was in shock when he

heard his name.
“It took me a while to stand up,” he
recalled Saturday. “It tookme awhile
to stand up. I didn’t
knowwhat to say.”
Those who know
Cushenberry best
would not be surprised
by his speechless re-
sponse.
LSU’s returning start-
ing center has always
been known as a quiet
man, an introverted
playerwho speaks onlywhenheneeds
to.
Little league football coaches re-
membered how they’d coached Cush-
enberry for two years and had only
heard his voice once.
His coaches at DutchtownHigh had
to pull words out of their young line-
man on a recruiting road trip.
Even at LSU, players aren’t used
to hearing their center’s voice boom
inside the expansive rooms inside the
program’s new football operations
building.
But when Cushenberry speaks?
Heads turn.
“I think that’s the best kind of lead-

ership,” LSU quarterback Joe Bur-
row said. “You have some leaders that

THE
QUIET
MAN

1C
SUNDAY

AUGUST 4, 2019sportssportssports
NOLA.COM

BY NATHAN BROWN
Staff writer

With all the hype surrounding
teams in LosAngeles andNewYork,
combined with the success of some
of the league’s premier franchises,
the Pelicans have been an after-
thought when the NBA considers
which teams to roll out for its open-
ing night.
Not anymore.
According to a report from The

Athletic, the Pelicans will face the

reigning champion Toronto Raptors
on Oct. 22, the NBA’s first night of
regular-season action. The Lakers
and Clippers also face off the same
evening, kicking off an anticipated
season after a summer full of All-
Star-caliber free-agent turnover and
an exciting top-level draft class.
It appears very likely that game

will be inNewOrleans and fans’ first
chance to see rookie sensation Zion
Williamson in the Smoothie King
Center for a regular-season game.
That WILL be the home-opener at

the Smoothie King Center, because
Elton John’s ‘Farewell Yellow Brick
Road’ tour is hitting Scotiabank on
that same night.
It is common for reigning champi-

ons to play the next season’s debut
at home, but Elton John is scheduled
to play concerts as part of his ‘Fare-
well YellowBrick Road’ tour on Oct.
22-23 in Toronto at the Raptors’ Sco-
tiabank Arena. The tour has stops in
Milwaukee on Oct. 19 and in India-
napolis onOct. 25,meaning resched-
uling the concert date would likely

be very difficult.
Should the teams play in New Or-
leans, the Raptors would be the first
reigningNBAchampions to open the
season on the road since the 2000-01
Lakers played their season debut
at Portland on Halloween to defend
their first of three consecutive titles.
Google’s unofficial event listings

for the Smoothie King Center also
have Oct. 22 as the team’s home
opener.

Pels to open season against Raptors, likely in N.O.

ä See PELICANS, page 2C

From last-day signee to
No. 18, Cushenberry

becomes voice of Tigers

STAFF FILE PHOTO
LSU offensive linemen Lloyd
Cushenberry waits for the start of a
drill during practice on Aug. 21, 2017.

ä Tulane
junior

Kuerschen
pumped to
start at free

safety.
Page 9C

ä See LSU, page 8C
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W I N N E R O F T H E P U L I T Z E R P R I Z E F O R L O C A L R E P O R T I N G

The first year under Matt
McCullough went well
with a district title at
Acadiana. Now the
Wreckin’ Rams are
hoping to make
another solid run
at the Dome.

story, page 5C

COMING
TOMORROW:

Opelousas hoping to
build on first playoff appearance
since 2004.

PREP FOOTBALL PREVIEW

BY ANDREA GALLO
and JOHN SIMERMAN
Staff writers

DiscipliningLouisiana judges
is a lot like “Fight Club.” The

first rule: You don’t talk about
it.
For the system to run as the

state Supreme Court intended,
everybody needs to keep quiet,
preferably forever. At least

that’s how the Judiciary Com-
mission, which investigates
allegations of judicial miscon-
duct in the state, interprets it.
The commission is among the
most secretive state bodies: It

threatens to hold anyone who
violates its confidentiality rules
in contempt of court.
Its rules demanding secrecy

are stricter and more sweep-
ing than those for misconduct

investigations into Louisiana
lawyers, or for ethics probes
into legislators and state and
local government officials.
The rules say a complaint

against a judge, any evidence

supporting it and the commis-
sion’s proceedings — including
their existence — must stay
secret unless the Judiciary

Case shines light on secrecy in judiciary
La. judges’ misconduct can remain hidden from public forever under disciplinary rules

BY TYLER BRIDGES
Staff writer

TheLouisianaDemocratic
Party continues to decline
under a Democratic gover-
nor, John Bel Edwards.
The one bright spot for
the party is that Edwards

is the front-runner heading
into the Oct. 12 gubernato-
rial primary against two
Republican challengers,
U.S. Rep. Ralph Abraham
and businessman Eddie
Rispone.

Edwards only
bright spot for
La. Democrats
Party on the decline in red state

The word “downtown” sometimes de-
scribes a city’s central business district.
But more often, it’s used to describe the
historical, political and geographic heart of
a city.
The Acadiana Advocate offices are mov-
ing this week— from 815 Johnston St. into
the heart of downtown at 203W. Third St.

Acadiana Advocate
moves downtown

BY BEN MYERS
Staff writer

A for-profit company is
poised to take control of hun-
dreds of government-owned
apartments designated for
use by low-income Lafayette
residents.Themovecomesas
private operators across the
country absorb public hous-
ing units in an effort to save
them from severe disrepair.
Fyffe, Alabama-based Van-
tageDevelopmentwill spend
millions of dollars on renova-
tions and manage all six of

the Lafayette Housing Au-
thority’s distressed, decades-
old apartment complexes, ac-
cording to plans. A combined
$35million in upgrades to the
C.O. Circle, Moss and Sim-
coe developments is to come
first, with improvements at
the Irene Street,MaconRoad
and Martin Luther King de-
velopments set for later.
Vantage and the housing
authority signed memoran-
dums of understanding last
year and are working to

FOR-PROFIT COMPANY TO TAKE
OVER LAFAYETTE PUBLIC HOUSING

Advocateswary overmanagement, renovations agreement

STAFF PHOTOS BY LESLIE WESTBROOK
Leshia Carter, left, president of the Lafayette Housing Authority Resident Council, throws up her hands while talking about
maintenance issues with her housing unit Thursday at the C.O. Circle housing development in Lafayette. Thelma Broussard, a
resident of the development and sergeant at arms for the council, speaks from the couch.

FILE PHOTO BY LESLIE WESTBROOK
Gov. John Bel Edwards gives a campaign speech July 9 at
The French Press in Lafayette.

A for-profit company is poised to take control of hundreds
of government-owned apartments, including the C.O. Circle
housing development, designated for use by low-income
Lafayette residents.ä See DOWNTOWN, page 8A

ä See DEMOCRATS, page 5A

ä See HOUSING, page 4A

ä See JUDICIARY, page 4A

KRISTIN
ASKELSON

HEALTH

1D
MONDAY

JULY 1, 2019livinglivingliving
NOLA.COM

BY SUZANNE PFEFFERLE TAFUR
Contributing writer

One of Touro Infirmary’s newest
employees is a bit of a celebrity.
When he moseys

through the health
care center’s Prytania
Street campus, people
rush toward him, hop-
ing for a quick cuddle.
But his uniform clear-
ly states, “Please don’t
pet me, I’m working”
— so they smile and
coo instead.
That’s because this

recent hire is a frisky,
4-month-old yellow Labrador re-
triever, training to become a ther-
apy dog.His name, stamped on his

plastic work badge, is Touro.
“Patients and staff are over-
whelmingly happy to see him,”
said Maggie Homer, a speech
therapist at Touro Infirmarywho’s
in charge of raising the pup.
“It can take us 15minutes to get
inside the hospital,” she said. “Ev-
erybody is calling him, and he’s
looking everywhere.”
Then, she said, Touro gets tired

and “splats” on his belly.

Veterans and dogs
The canine eventually makes

his way into the Touro Rehabili-
tation Center, where he works
alongside fellow Lab Indie, 3
months old.
Both puppies arrived at Touro

through a partnership with Unit-

ed States Veterans Service Dogs,
aMarrero-based organization that
pairs veterans with physical and
mental disabilities with a service
dog.
“The USVSD breeds dogs to be-

come service dogs, and then they
find volunteers to be puppy rais-
ers,” said Maggie Watson, Indie’s
puppy raiser and a physical thera-
pist at Touro.
Cody Bellanger, the CEO and

director of training and client
services for the veterans organi-
zation, was familiar with Touro’s
Rehabilitation Center and thought
the facility would be an ideal set-
ting for a program that pairs Tou-
ro’s staff with puppies.

LABS LEARN HOW TO ASSIST DISABLED
VETERANS AT NEW ORLEANS REHAB CENTER

Labrador puppies Indie
and Touro are training at
Touro Infirmary to become
service dogs for veterans.

STAFF PHOTOS
BY SOPHIA GERMER

ABOVE: Maggie
Watson, left, with
Indie, and Maggie
Homer, with Touro,
use positive, rewards-
based training to
teach the puppies
basic commands.
LEFT: Touro wears a
vest and official name
tag, alerting humans
to his status as a
service dog in training.

BY MARI A. SCHAEFER
The Philadelphia Inquirer (TNS)

There seems to be very little
that Republicans and Demo-
crats agree upon in these times
of harsh political discourse, but
aDrexelUniversity researcher
may have found one: the role of
scientific evidence in develop-
ing and shaping health care.
In a 2018 survey, 532 Ameri-

cans were asked to identify
with a political party and then
rate the extent to which six
factors such as industry influ-
ences, evidence and budget
“should have” and “currently
have” on the decisions made
by representatives in the U.S.
Congress.
The survey also looked at the

influencedoctor groups and cit-
izens had on health policy. The

study was published last week
in the journal Translational Be-
havioral Medicine.
“Policymaking is political at

the end of the day,” said Jona-
than Purtle, study author and
assistant professor of health
management and policy in
Drexel’s Dornsife School of
Public Health.

What Republicans and Democrats
agree upon may surprise you

ä See AGREE, page 2D

Previous studies
have found that

groups that
represent doctors,
like the American

Medical Association,
are extremely

powerful in shaping
healthy policy, but
a new study found
that doctors were

not thought to have
much influence.

PROVIDED PHOTO BY
METRO SOURCE

PUPPY’SpurposeA

ä To see
a video of
the pups,
go to nola.

com.

ä See PUPPY, page 2D
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Community Papers

New Orleans
Crescent City • East Jefferson

West Bank • St. Tammany
St. Tammany Farmer

Inserts available by zip code and by zone in New Orleans

530,512
PRINT READERS PER WEEK
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Community Papers

Baton Rouge
Livingston • Southeast • Zachary Plainsman • Midcity

Ascension • Southside • Clinton Watchman
St. Francisville Democrat

Inserts available by zip code and by zone in Baton Rouge

206,000
PRINT READERS PER WEEK
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Preprints - New Orleans

Quantities available upon request
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Preprints - Baton Rouge

Quantities available upon request
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Preprints - Lafayette

Quantities available upon request
Full zone required
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Adore is a glossy magazine published in New Orleans. It is delivered with the 
Times-Picayune/New Orleans Advocate to our loyal subscribers as well as 
distributed at key locations around town.

Each issue of Adore covers fashion, home design and décor in New Orleans. 
Reaching an upscale audience, Adore is a tantalizing glimpse into what your 
potential customers will find and fall in love with each season.

Adore reaches more than 148,000 readers with each issue.
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In a city where culture is king, no publication covers the arts, entertainment, 
and cuisine of New Orleans like Gambit.

With an average issue readership of 154,143* and a 97% pickup rate each 
week, Gambit continues to be essential reading for New Orleans natives and 
tourists alike.
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ad sizes - broadsheet

tabloid special products

preprint inserts

mechanical specs - print

1 column.....................1.583”

2 column.....................3.291”

3 column.....................5.000”

4 column.....................6.708”

5 column.....................8.416”

6 column.................. 10.125”

Double Truck......... 21.125”

DISPLAY & CLASSIFIED

INSIDE OUT

LEGAL CLASSIFIED

1 column.....................1.013”

2 column.....................2.152”

3 column.....................3.291”

4 column.....................4.430”

5 column.....................5.569”

6 column.....................6.708”

7 column.....................7.847”

8 column.....................8.986”

9 column.................. 10.125”

1 column........................1.75”

2 column.....................3.625”

3 column...........................5.5”

4 column.....................7.375”

5 column........................9.25”

Spadea.......  2 Files @ 10.125” x 20”

................................2 Files @ 5” x 20”

Front Page Strip Ad......10.125” x 3”

Front Page Ad Note 
(no bleed)................................3” x 2.38”

Front Page Ad Note 
(bleed)...................................3.2” x 2.65”

Skybox Ad.....................3.291” x 1.50”

Overline Ad......................10.125” x 2”

Sizes available

10.5” x 12”       8.5” x 11”
5.5” x 11”          8.5” x 7”
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10.125 INCHES

9.25 INCHES

For ads to be built, image file formats accepted for ad materials include: JPEG, 

PNG, TIF, EPS, AI. Please provide high resolution images. Images pulled from the 

internet or a Google image search will reproduce poorly in most cases. For ad 

copy, we accept Microsoft Office documents.

For camera-ready ads, the preferred file format is a press-ready PDF or EPS file 

with fonts converted to outlines and raster images in CMYK color format.

LINE SCREEN		  DPI		  TOTAL INK LIMIT	

100			   200		  240

Inside Back
Cover

Back
Cover

Front Page Flap
Gutter - .125”
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Full Page
INCHES

10.125 x 20

1/2 Page
VERTICAL
INCHES

5 x 20

1/4 Page
VERTICAL
INCHES

5 x 9.9

1/8 Page
SQUARE
INCHES

5 x 5

1/12 Page
SQUARE
INCHES

3.291 x 5

1/2 Page
HORIZONTAL
INCHES

10.125 x 9.9

1/4 Page
HORIZONTAL
INCHES

10.125 x 5

Strip Ad
HORIZONTAL
INCHES

10.125 x 3

Center Spread
DOUBLE TRUCK
(WITH FOLIOS)
INCHES

21.125 x 20
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ad sizes - broadsheet
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Full Page
INCHES

9.25 x 10

1/2 Page
VERTICAL
INCHES

9.25 x 5

1/4 Page
VERTICAL
INCHES

3.625 x 6.5

2 col x 10
VERTICAL
INCHES

3.625 x 10

2 col x 6
VERTICAL
INCHES

3.625 x 6

1/4 Page
HORIZONTAL
INCHES

5.5 x 4.25

2 col x 3
HORIZONTAL
INCHES

3.625 x 3

4 col x 3
HORIZONTAL
INCHES

7.375 x 3

ad sizes - InsideOut - 5 column tab

Full Page
INCHES

9.221 x 
9.999

1/4 Page
SQUARE
INCHES

4.551 x
4.937

1/2 Page
VERTICAL
INCHES

4.551 x 
9.999

1/2 Page
HORIZONTAL
INCHES

9.221 x
4.937

ad sizes - Acadiana Homes
FREE

Special Advertising Section

ACAD I ANA

homes.TheAcadianaAdvocate.com

January | 2 - 8 | 2021

402Woods Crossing Crossing | Lafayette... see page 4
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InsideOutH O M E l D E S I G N l G A R D E N l R E A L E S T A T E

THE TIMES-PICAYUNE | THE NEW ORLEANS ADVOCATE
AUG. 3, 2019

COLOR IS CRUCIALArt-loving owners keep house full of local works
INSIDEGREEN THUMB: A detail-rich block on Grand Route St. John Page 10 | COOL STUFF: Luxurious dorm decor Page 8
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Full Page
INCHES

9.221 x 
9.999

1/4 Page
VERTICAL
INCHES

2.216 x 
9.999

1/4 Page
SQUARE
INCHES

4.551 x
4.937

1/2 Page
VERTICAL
INCHES

4.551 x 
9.999

1/2 Page
HORIZONTAL
INCHES

9.221 x
4.937

1/8 Page
VERTICAL
INCHES

2.216 x
4.937

1/16 Page
SQUARE
INCHES

2.216 x
2.406

1/8 Page
HORIZONTAL
INCHES

4.551 x
2.406

Center Spread
DOUBLE TRUCK
(WITH FOLIOS)
INCHES

20 x 
9.999
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ad sizes - Gambit and Lagniappe

Coolinary: Restaurants roll
out August promotions

lagniappeTHE TIMES-PICAYUNE | THE NEW ORLEANS ADVOCATE

August 1, 2019

page 7

SOUNDS.................4 STAGES...................6 FILMS...................10 EVENTS ................18

WHITE LINEN: BEST BESTS FOR
THE HOTTEST ART SHOW IN TOWNpa

ge
12

WHATEVER
FLOATS

YOUR BOAT
WHY ROBERT TANNEN
BOUGHT A LIFEBOAT

FOR WHITE LINEN NIGHT
PAGE 12



NORTH LOUISIANA

ad sizes (digital)

ad sizes (print)
Full Page
INCHES
TRIM:
8.375 x 10.875
BLEED:
8.625 x 11.125

FULL

1/2 Page
INCHES
7.875 x 5.125

1/4

1/4 Page
INCHES
3.85 x 5.125

HALF

1/3

HALF

1/2 Page
INCHES
3.75 x 10.375

1/3 Page
INCHES
2.5 x 10.375

2-Page Spread
INCHES
TRIM:
16.75 x 10.875
BLEED:
17 x 11.125

2-PAGE SPREAD

SUPER BILLBOARD
970 x 250 pixels

•	 Static

•	 File size under 100 KB

•	 Accepted file formats: jpg, png, gif

•	 Third-party ad tags not accepted

PARALLAX
DESKTOP: 1500 x 600 pixels

MOBILE: 300 x 350 pixels

•	 Static

•	 File size under 1 MB

•	 Accepted file formats: jpg, png, gif

•	 Third-party ad tags not accepted

RECTANGLE
300 x 250 pixels

•	 Static

•	 File size under 100 KB

•	 Accepted file formats: jpg, png, gif

•	 Third-party ad tags not accepted

NOLAADORE.COM

Everything you adore is now online! We 
present Adore’s new digital home covering 
all things fashion, home design, décor, and 
more in New Orleans. Read original stories, 
browse past issues, and shop of-the-moment 
guides in one easy-to-navigate website. 
Content will be published 2-3 times a day, 
Monday through Friday.

CONTACT YOUR NEW ORLEANS ADVOCATE SALES REP TODAY!

300 x 250 - $600/month

970 x 250 - $900/month

Parallax - $1,200/month

Introductory pricing 
(3 month minimum):
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print specifications - color settings
downloading ink settings

things to keep in mind while designing

exporting your ad

1.	 Visit: https://www.theadvocate.com/site/ink_settings_advocate.html (link is clickable here)

2.	 Download the custom ink settings for all our newsprint publications (.csf file) to your desktop or a folder for later use.

3.	 (Adobe Software) In the top menu bar, click Edit > Color Settings (steps are the same for Photoshop and InDesign).

4.	 Click load and navigate to the location of your file and click open; then click OK.

5.	 Click Edit > Assign Profile.

6.	 In Photoshop: choose the middle option for “Working CMYK: GambitInkSettings”; click OK. 

7.	 In InDesign: choose the middle option for RGB Profile “Assign current working space: sRGB IEC61966-2.1” for CMYK Profile 

choose “Assign current working space: GambitInkSettings.” Click OK.

8.	 Create a new file using the file sizes provided.

9.	 Design your ad.

1.	 Only CMYK or Grayscale color range files are accepted - (Pantone, Spot and RGB will be converted accordingly)

2.	 No rich black for text - For black text, only use 100% black (no rich black)

3.	 All text is at least 8 points in size - If your text is not 100% black and is on top of any color but white (referred to as knock-out 

text), it must be at least 12 points and bold without any thin strokes or serifs. Avoid any ornate script fonts especially in knock-out 

situations.

4.	 Your files are flattened - Make sure when placing logos and images used are flattened files. Do not place layered logos or images. 

Design your ad.

1.	 Be sure to name your files clearly including the client name and date: 

- Good: HarrysShop_6-13-15.pdf 

- Bad: 0942523AXD-Advocate.pdf

2.	 If your ad was made in Photoshop only - save the document as a .psd, then flatten it, then save it as a Photoshop PDF (make 

sure “Embeded Color Profile: GambitInkSettings” is checked at the bottom). Don’t overwrite your original layered file. Saving it as 

a different file will keep your original file unflattened in case more changes need to be made. High quality photoshop JPEGS are 

also accepted. 

3.	 If your ad was made in both Photoshop and InDesign - Save your photoshop documents, relink any files in InDesign. Make sure 

text is 100% Black with no other colors, convert text to outlines and export using File > Adobe PDF Presets > [PDF/X-1a:2001]… 

and submit your ad. (Remember to un-outline your font before you save your file so the text will still be editable if there are any 

typos.)

https://www.theadvocate.com/site/ink_settings_advocate.html
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PUBLICATION	 SPACE RESERVATION	 AD RELEASE
Monday Daily	 Thursday @ 5 pm	 Fri @ 5 pm
BR, NO, ACA Classified	 Thursday  @ 5 pm	 Fri @ 5 pm

Tuesday Daily	 Friday  @ 5 pm	 Mon @ 5pm
BR, ACA Classified	 Friday  @ 5 pm	 Fri @ 5 pm
NO Classified	 Friday  @ 5 pm	 Fri @ 5 pm

Wednesday Daily	 Monday  @ 5 pm	 Tues @ 5 pm
BR, ACA Classified	 Monday @ 5 pm	 Mon @ 5 pm
NO Classified	 Monday @ 5 pm	 Mon @ 5 pm
Living BR	 Monday @ 5 pm	 Mon @ 5 pm
Living NO	 Monday @ 5 pm	 Mon @ 5 pm
Living ACA	 Monday @ 5 pm	 Mon @ 5 pm

Thursday Daily	 Tuesday @ 5 pm	 Wed @ 5 pm
BR, ACA Classified	 Monday @ 5 pm	 Tues @ 5 pm
NO Classified	 Monday @ 5 pm	 Tues @ 5 pm
Lagniappe	 Monday @ 11 am	 Tues @ 5 pm
Living BR	 Monday @ 5 pm	 Tues @ 5 pm
Living NO	 Monday @ 5 pm	 Tues @ 5 pm
Living ACA	 Monday @ 5 pm	 Tues @ 5 pm

Friday Daily	 Wednesday @ 5 pm	 Thurs @ 5 pm
BR, ACA Classified	 Thursday @ 10 am	 Wed @ 5 pm
NO Classified	 Tuesday @ 5 pm	 Wed @ 5 pm
Living BR / RED	 Wednesday @ noon	 Wed @ 5 pm
Living NO	 Wednesday @ noon	 Wed @ 5 pm
Living ACA	 Wednesday @ noon	 Wed @ 5 pm

Saturday Daily	 Thursday @ 5 pm	 Fri @ 5 pm
BR, ACA Classified	 Thursday @ 5 pm	 Thurs @ 5 pm
NO Classified	 Thursday @ 5 pm	 Thurs @ 5 pm
Acadiana Homes	 Tuesday @ Noon	 Thurs @ 4 pm
Living BR	 Thursday @ noon	 Thurs @ 5pm
Inside/Out NO	 Tuesday @ noon	 Thurs @ 5pm
Living ACA	 Thursday @ noon	 Thurs @ 5pm

Sunday Daily	 Thursday @ 5 pm	 Fri @ 5 pm
BR, ACA Classifieds, Homes	 Wednesday @ 5 pm	 Fri @ 5 noon
NO Classifieds, Homes	 Wednesday @ 5 pm	 Fri @ 5 noon
Living & Business and Pre-Run A	 Wednesday @ 5 pm	 Thurs @ 5 pm
New Orleans Spotlight - Select Distribution	 Monday @ 5 pm	 Tues @ 5 pm

Weekly Newspapers (New Orleans Wednesday | Baton Rouge Wednesday)                                                   	
New Orleans	 Thursday  @ 2 pm	 Fri @ 5 pm
Livingston	 Friday @ Noon	 Mon @ 5 pm
Ascension, Zachary & Extras	 Friday @ 5 pm	 Mon @ 5 pm

Gambit	 2 Fri Prior @ 5 pm	 Wed @ 5 pm

deadlines - print
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preprints - packaging requirements
1.	 SUPPLEMENT SIZE - Preprinted supplements must be at least 5” x 7” and not larger than 19.5” x 12”

2.	 PAPER WEIGHT - Minimum 30 lb. stock - Tabloid; Minimum 60 lb. stock - Single Sheet

3.	 SKIDS – Skids must be solid base with solid runners. Skid top should be wood and must conform in size to skid 

base. Deck must be covered in cardboard before loading to prevent curling. Shrink-wrapped skids must have 

protective corners to prevent crimping.

4.	 STACKING – Supplements must be brick stacked in convenient lifts (6” - 12”) well jogged with no turns. Sup-

plements should be stacked so that most folded edges are turned toward the center of the skid. Cardboard tie 

sheets must be used between each tier and on top to prevent distortion. Supplements must be recessed a min-

imum of 1/2” from the skid edge (all sides) to prevent crimping. DO NOT tie supplements together in bundles. 

Skids must not exceed 5 1/2 feet in height, must contain the same number of copies (except for the last), and 

must contain a skid tag indicating product and number of copies.

5.	 DELIVERY - The shipping and receiving dock hours are 6:00 a.m. to 3:00 p.m., Monday through Friday. Deliv-

eries cannot be accepted outside of those times. The Times-Picayune, Baton Rouge Advocate and Acadiana 

Advocate daily and Sunday paper deadline is 11 business days prior to run date. Baton Rouge community pa-

pers (Zachary Plainsman, Mid-City, Southside, Southeast, Ascension and Livingston-Tangipahoa), New Orleans 

community papers (Crescent City, West Bank, East Jefferson and St. Tammany)  are 9 business days prior. All 

inserts should be broken out and labeled according to edition. Earlier deadlines apply for holidays. Contact 

your sales representative for details. A proper bill of lading must accompany all shipments and should indicate 

(1) Advertiser, (2) # of skids and (3) # of copies. Supplements must be shipped prepaid to: 

 

The Advocate 
10715 Rieger Road, Baton Rouge, LA 70809 
Phone: 225-377-2051 or 225-377-7078 

 

Earlier deadlines apply for holidays. Call for details. 



NORTH LOUISIANA

digital specifications
LEADERBOARD (desktop only)
728 × 90 pixels

•	 Animated or Static

•	 File size under 100 KB

•	 Accepted file format: jpg, png, gif

•	 Third-party ad tags are accepted

RECTANGLE
300 × 250 pixels

•	 Animated or Static

•	 File size under 100 KB

•	 Accepted file format: jpg, png, gif

•	 Third-party ad tags are accepted 

REVEAL
DESKTOP
1920 × 600 pixels

•	 Animated, video (optional) or static

•	 Max File size: 150k

•	 Can include up to three images

•	 File format: jpg, png, YouTube

•	 Max video length: 15–30 seconds

•	 Max of one video

•	 Max of one URL clickthrough

•	 Third-party ad tags not accepted

MOBILE
800 × 250 pixels

•	 Static only

•	 Max File size: 80k

•	 File format: jpg, png

•	 Third-party ad tags not accepted

CLICK HERE FOR EXAMPLE

CLICK HERE FOR EXAMPLE

CLICK HERE FOR EXAMPLE



NORTH LOUISIANA

digital specifications
SLIDING BILLBOARD
DESKTOP
1170 × 50 pixels (collapsed)

•	 Static

•	 File size under 100 KB

•	 Leave blank a 100px overlay on 

right for expand/close button

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted

1170 × 300 pixels (expanded)

•	 Static

•	 File size under 100 KB

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted

MOBILE
480 × 50  pixels (collapsed)

•	 Static

•	 File size under 40 KB

•	 Leave blank a 50px overlay on 

right for expand/close button

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted

480 x 250 pixels (expanded)

•	 Static

•	 File size under 40 KB

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted

CLICK HERE FOR EXAMPLE

MOBILE BANNER
320 × 50

•	 Animated or Static

•	 File size under 100 KB

•	 Accepted file format: jpg, png, gif

•	 Third-party ad tags are accepted

CLICK HERE FOR EXAMPLE

https://www.theadvocate.com/advertise/demos/sliding_billboard/
https://www.theadvocate.com/advertise/mobile_banner_demo/?1485551773416


NORTH LOUISIANA

digital specifications
SLIDING BILLBOARD 
& SITE SKIN
DESKTOP
1170 x 50 pixels (collapsed)

•	 Static

•	 File size under 100 KB

•	 Leave blank a 100px overlay on 

right for expand/close button

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accept-

edThird-party ad tags not accepted

1170 x 300 pixels (expanded)

•	 Static

•	 File size under 100 KB

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted-

Leave blank a 100px overlay on 

right for expand/close button

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted

SITE SKIN DESKTOP 

500 x 1100 (2)

•	 Static

•	 File size under 100 KB

•	 One image anchors to the left 

side of the browser window, the 

other to the right

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted

EXPANDABLE VIDEO (desktop only)
300 x 250 pixels expands to 600 x 250 pixels

•	 Need static 300x250 (JPG or PNG) - File size under 100 KB

•	 Need original video file

•	 Need logo

•	 Need Clickthrough URL

•	 Need URLS for Social Media Channels (Optional)

•	 Third-party ad tags not accepted

MOBILE
480 × 50  pixels (collapsed)

•	 Static

•	 File size under 40 KB

•	 Leave blank a 50px overlay on 

right for expand/close button

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted

480 x 250 pixels (expanded)

•	 Static

•	 File size under 40 KB

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted

CLICK HERE FOR EXAMPLE

CLICK HERE FOR EXAMPLE

https://www.theadvocate.com/advertise/demos/sliding_billboard/
https://www.theadvocate.com/advertise/demos/expandable_video/


NORTH LOUISIANA

digital specifications
BOTTOM BAR
DESKTOP
1170 x 50 pixels

•	 Static

•	 File size under 100 KB

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted

SUPER BILLBOARD
DESKTOP ONLY
970 x 250 pixels

•	 Static

•	 File size under 100 KB

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted

MOBILE
480 × 50  pixels

•	 Static

•	 File size under 40 KB

•	 Accepted file formats: jpg, png

•	 Third-party ad tags not accepted

CLICK HERE FOR EXAMPLE

https://www.theadvocate.com/advertise/demos/bottom_bar/


NORTH LOUISIANA

out-of-home specifications

Educational Institutions

•	 1080x1920

•	 1280x720

•	 1920x1080

Bars

•	 1080x1920

•	 1280x720

•	 1366x768

•	 1920x1080

•	 720x480

Casual Dining Venues

•	 1080x1920

•	 1280x720

•	 1366x768

•	 1920x1080

•	 720x480

Golf Carts

•	 640x360

Hotels

•	 1920x1080

Movie Theaters

•	 1080x1920

Entertainment - Recreational

•	 1366x768

•	 720x480

Entertainment - Sports

•	 1080x1920

•	 1920x1080

Entertainment - Sports

•	 1080x1920

•	 1920x1080

Outdoor Billboards

•	 1400 x 400

•	 1920 x 1080

•	 256 x 192

•	 320 x 144

•	 320 x 160

•	 336 x 128

•	 336 x 160

•	 368 x 176

•	 384 x 144

•	 384 x 216

•	 400 x 160

•	 414 x 198

•	 432 x 144

•	 464 x 144

•	 480 x 112

•	 480 x 216

•	 496 x 160

•	 528 x 144

•	 528 x 160

•	 544 x 144

•	 544 x 160

•	 560 x 144

•	 576 x 216

•	 612 x 162

•	 624 x 176

•	 630 x 162

•	 630 x 180

•	 640 x 180

•	 640 x 192

•	 660 x 180

•	 704 x 192

•	 720 x 208

•	 752 x 208

•	 760 x 180

•	 840 x 400

ALL DIMENSIONS IN PIXELS 
PLEASE CONTACT YOUR SALES REPRESENTATIVE ON VIDEO OPTIONS

out-of-home specifications



NORTH LOUISIANA

out-of-home specificationsout-of-home specifications

Outdoor Billboards - Highway

•	 1000 x 625

•	 1400 x 400

•	 1600 x 400

•	 840 x 400

Outdoor Billboards - Spectacular

•	 1920x1080

Point of Care - Doctors’ Offices

•	 1080x1920

•	 1280x720

•	 1360x768

•	 1366x768

•	 1920x1080

Point of Care - Hospital

•	 1920x1080

Point of Care - Veterinary Office

•	 1280x720

•	 1360x768

•	 1920x1080

Retail

•	 1280x720

•	 1920x1080

•	 208x720

•	 720x208

Retail - Convenience Store

•	 1280x960

•	 1920x1080

Retail - Gas Stations

•	 1280x960

Retail - Grocery

•	 1080x1920

•	 1280x960

•	 1920x1080

•	 728x90

Retail - Liquor Stores

•	 1920x1080

Retail - Malls

•	 1080x1920

Retail - Pharmacies

•	 1920x1080

•	 728x90

•	 970x90

Transit - Airports - Baggage Claim

•	 1080x1920

•	 1920x1080

ALL DIMENSIONS IN PIXELS 
PLEASE CONTACT YOUR SALES REPRESENTATIVE ON VIDEO OPTIONS
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